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Exercise 1: Working with ArcMap 9.1 
 
This introductory lab will help you become familiar with the ArcMap interface and tools. 
You will learn how to add data, modify symbology, add labels, work with tabular data, 
join tables, perform queries and create map payouts. 
 
Add Data 
 
Step 1: Start ArcMap (in the ArcGIS menu) and  
begin a new empty map. 
 
 
 
 
 
 
 

 
   

Data Frame Properties 
 

 

Step 2: Click the ‘Add 
Data’ icon 
and browse to 
c:\NR402\Idaho. 
Choose the data layer 
counties_id_idwr 
 

Right-click on ‘Layers’ at the top of the table of 
contents, then select ‘Properties’ to view the data 
frame properties.  

NOTE: The FIRST layer added to the data frame 
will define the map projection for the data frame. 
Additional layers will be ‘projected on the fly’ to 
match the data frame projection (if they have a 
map projection defined). If a data layer projection 
is not defined you will get a warning message 
telling you that the projection is not defined and 
the data may not line up with other data in the 
view. 
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Description of tabs in Layer Properties 
 
General – Descries the layer name and specifies the range of scales the layer will be shown within.  
Source - Location of data set on the computer; map coordinate system 
Selection – Specify the symbol used for selected features of this data layer 
Display – Transparency; Hyperlinks; Feature exclusion 
Symbology – Legend editor 
Fields – Attributes in the data set 
Definition query – Gives the option to only show a selected part of the data layer 
Labels – Options to change labeling methods and fields 
Join & Relates – Lists tables that has been joined or related to this layer 

Description of tabs in Data Frame Properties 
  
General – Descries the data frame name, map and display units units. 
Data Frame – Gives the user the option to specify an extent or scale for data display. 
Coordinate System – Describes the current map coordinate system of the data frame (map 
projection). The FIRST layer added to the data frame will define the map projection for the data 
frame. Additional layers will be ‘projected on the fly’ to match the data frame projection (if they 
have a map projection defined). 
Illumination – Sets the illumination of the data frame 
Grids – Adds grids or graticules to a map layout. Graticules are map coordinate grids or tic marks 
labeled with current map coordinates. 
Labels – Defines label priorities between data layers in the data frame. 
Annotation Groups –   
Extent Rectangles – An extent rectangle shows the extent of the data in one of the other frames 
and automatically updates if the extent changes. Useful for making locator maps. 
Frame – Gives the user options to modify the neat line around the data frame in the map layout. 
Size and Position– Specify the size and position of the data frame 
Feature Link– Specify how links between vertices and survey data will be drawn by the Survey 
Analyst Extension. 

Each data layer in the table of contents also has Properties. Right-click on the layer to view the 
Layer Properties. 
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Open Attribute Table 

  
     

 
 
 
Edit Legend 
 

 

Step 3: The Idaho counties will 
appear in a single symbol. 
 
Right-click on the 
counties_id_idwr layer and 
select Open theme table 

Attribute table of Idaho counties. 
Each polygon in the spatial dataset 
corresponds to a line in the attribute 
table. 
Each polygon may have many 
attributes describing the properties of 
the polygon, for example area, county 
name, population etc. 

Step 4: Double click on 
counties_id_idwr to start the 
Legend Properties window 
 
You can also start the Legend 
Properties by right-clicking 
on the counties_id_idwr layer 
– then select Properties. 
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Labels 
 
 
 
 
Add Labels 

 
 

 

Step 5: Click on the Symbology 
tab to edit the display of the 
counties. Select Categories 
instead of Single Symbol to 
enable display of the counties in 
different colors 
 
Choose Value Field NAME to 
display the counties by their 
names. 
 
Select a color scheme 
 
Click Add All Values 
Click OK 

Step 6: Bring up the Layer 
Properties again. Go to the 
Labels tab. 
 
Set the label field to NAME 
(the county names). 
 
Change the symbol size to 5. 
 
Click OK. 

Step 7: Right-click 
on the county layer 
and select Label 
Features to display 
the county names 
on the map. 
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Step 8: It would be desirable to move some labels to make them more readable. Before 
you can move labels you must convert the labels to an annotation layer. 
 
Right-click on counties_id_idwr and select Convert Labels to Annotation 
 

 
 

 
 
 
Joining and Linking Tables 
 
In this example we will link population information to the county data in order to display 
Idaho based on population count. The table idaho_pop.dbf contains information about 
county population in 1990 and 1997. 

 

Step 9: Click on the ‘pointer  
arrow’. You can now select 
and move individual labels 
for better placement. 
If you double-click on a 
label you can modify the 
text as desired. 

Step 10: Click on the Add Data 
icon and select idaho_pop.dbf 

Store the annotation in the 
map. 
 
Click ‘Convert’. 
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Step 12: Close tables. Right-click on county_id_idwr and select Joins and Relates - Join. 
 

 
  

 

Step 11: Open the table 
Idaho_pop.dbf and also 
the attribute table for the 
Idaho counties. 
 
The two tables can be 
joined on the county 
name in upper case font. 
 
Notice that the spelling 
of the county names 
must be identical in the 
two tables – otherwise 
the tables will not join 
properly. 

Step 13: On the first line select 
option: Join attributes from a 
table. 
 
We will join based on the 
attribute NAME. 
 
We will join to Idaho_pop and 
use the attribute NAME_UP in 
that table. OK. 
Select YES to Indexing. 
 
Open the county attribute table 
to confirm that the join was 
successful. 

Step14: Use the Layer Properties (the 
Symbology tab) to display Idaho 
counties with graduated colors (in the 
Quantities menu) based on the 
population in 1990. 
Choose a color ramp. 
You can manually modify colors, 
number of classes and class breaks. 
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Edit Attribute Tables 
 
In this section we will add an attribute to the county attribute table that shows percent 
population increase from 1990 to 1997. 
 
Step 15: Open the attribute table to the counties_id_idwr. Select Options in the lower 
right corner. Select Add field.  
Name the new field pop_inc. Type: float Precision: 6; Scale; 1 
 

 
 

 
 
Step 18: Display Idaho counties using the new attribute population increase from 1990 to 
1997. 
 
 

Step 16: Right-click on the new field 
name in the table and select Calculate 
field values. 
It is OK to calculate the new values 
outside of an editing session. 

Step 17: In the field calculator add the expression: 
 
100 *  ( [idaho_pop.POP1997]- 
[idaho_pop.POP1990])/ [idaho_pop.POP1990] 
 
Rather than typing ‘idaho_pop.POP1997’ etc. – 
select from the ‘Fields’ list.  
 
The percent population increase by county will be 
calculated and stored in the database. 
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Query 
 
As an example of a Query, query for the counties with more than 30% growth. 
 
Step 19: Choose Select by attribute under Selection in the main menu. 
 
 

 
 
 

 
 
 
 
 
 

Step 20: Select pop_inc greater than 30%. Click OK. 
The counties with more than 30% population growth 
will be selected (appear with a blue outline). 
 
Your selected counties can be saved in a separate 
shapefile. Save the selection in a new shapefile by right-
clicking on the county layer – choose Data – Export 
Data. 
(if you instead chose Create Layer from Selected 
Feature, a new shape file will NOT be created, simply a 
data subset that is tied to the original shapefile. The 
layer file cannot be used by itself, but must always be in 
the same folder as the original shapefile)  
 
Specify a location and name for the new shapefile. You 
can ‘turn off’ the new shapefile if you wish.    
 
Clear selection: Right-click on the county layer – choose 
Selection – choose Clear Selected Features. 
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Layout 
 
The data in the ‘map window’ can be displayed as a Data View or a Layout View. There 
are two ways to switch between the Data View display and the Layout View display. The 
Layout View allows you to create a map layour that incorporates a scalebar, north-arrow, 
legend etc. 
 

 
 
 
 
 
 
 
 
You are now ready to add the common cartographic components to the map layout. A 
proper layout should contain the following seven components: 
 
 
 
 
 
 
 
 
 
 

Step 20: Choose Data 
View or Layout View in 
the main View menu 

You can toggle between Data 
View and Layout View using 
the two icons in the lower left 
corner of the view frame. 
The icon to the left (world) 
puts the display window in 
Data View mode. 
The icon to the right (sheet of 
paper) puts the display 
window in Layout mode. 

• Main map 
• Legend 
• Title 
• Scale bar 
• North Arrow 
• Data source 
• Locator map (if applicable)
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Step 22: In order to add a meaningful scalebar you must first specify the map units for the 
data frame. The county shapefile is projected in Idaho Transverse Mercator Projection 
and the map units are meters. We will talk more about map projections in week 2 of this 
course. 
 
Select Data Frame Properties in the View menu. Click the General tab. Specify meters 
for the map units. 
 
Step 23: Add a scale bar to the layout. 
 
Step 24: Add a title to the layout: “ Population change by county in the state of Idaho 
1990 to 1997” 

 
 

 
 
Step 26: Add information about the data source. The data source information is here 
given in the box below:  
 
 
 
 
You can put a neat line around the text by selecting Neatline in the Insert menu. 
 

Step 21:  Put the view frame in 
Layout mode. 
 
Using the options in the Insert 
menu you can now add scale 
bar, north arrow, text and more 
data frames. 
 
Add a north arrow to the layout.  

Step 25: Add a legend to the layout. 
Before you add the legend – change the 
name of the layer to ‘Population change’ 

County boundaries from Idaho Water Resources. Population data from the 
University of Idaho Library – INSIDE Idaho project. 
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Step 28: Add the states using the ESRI data that comes with ArcView. 
C:/ESRI/ESRIDATA/USA/STATES 
Zoom to the continental US. All the states are showing with a single symbol – however 
we want to emphasize the location of Idaho on the USA map. 
 
 

 
  
 
 
 
 

Step 27: As the last item we will 
add a locator map showing the 
location of Idaho in the 
continental United States.  
Select Data Frame in the insert 
menu. 
A new data frame will appear in 
the layout and also in the layer 
table. 
 
With the new data frame active 
click on the Data View icon. 
 

Step 29: Make 
STATES the active 
layer. Choose Select 
by attribute in the 
Selection menu. 
 
Query for 
STATE_NAME = 
Idaho 
 
Apply then Close 
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Step 30: Right-click on STATES. Choose Selection then Create Layer from Selected 
Features. (or create a new shapefile by selecting Data-Export data) 
 

 
 
Step 31: Select colors for the states and for Idaho. Go back to Layout mode and view 
your finished work. 
 

 
 
 
Step 32: Save your map as a .jpg file by selecting  
Export Map in the File menu. Set the file type to .jpg and the resolution to 100 dpi. This 
map is the deliverable for Exercise 1. 

In this exercise you learned how to work 
with vector data in ArcMap. 
You learned how to:  
 

• Start a new ArcMap project 
• Add data to an ArcMap project 
• Understanding Dataframe Properties 

and Layer Properties 
• View and edit tables 
• Work with the Symbology in 

ArcMap 
• Add labels to a map 
• Query a GIS database and save the 

selection as a separate data layer 
• Create a map layout 
• How to export a map 

 


